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Disclaimer

The information contained in this document is for general informational purposes only and does
not constitute an offer, solicitation, invitation or recommendation to buy or sell any futures
contracts or other products or to provide any investment advice or service of any kind. This
document is not directed at, and is not intended for distribution to or use by, any person or entity in
any jurisdiction or country where such distribution or use would be contrary to law or regulation or
which would subject Hong Kong Exchanges and Clearing Limited (“HKEX”), Hong Kong Futures
Exchange Limited (“HKFE”) (together, the “Entities”, each an “Entity”), or any of their affiliates, or
any of the companies that they operate, to any registration requirement within such jurisdiction or
country.

No section or clause in this document may be regarded as creating any obligation on the part of
any of the Entities. Rights and obligations with regard to the trading, clearing and settlement of any
futures contracts effected on HKFE shall depend solely on the applicable rules of HKFE and the
relevant clearing house, as well as the applicable laws, rules and regulations of Hong Kong.

Although the information contained in this document is obtained or compiled from sources
believed to be reliable, neither of the Entities guarantees the accuracy, validity, timeliness or
completeness of the information or data for any particular purpose, and the Entities and the
companies that they operate shall not accept any responsibility for, or be liable for, errors,
omissions or other inaccuracies in the information or for the consequences thereof. The
information set out in this document is provided on an “as is” and “as available” basis and may be
amended or changed. It is not a substitute for professional advice which takes account of your
specific circumstances and nothing in this document constitutes legal advice. Neither of the
Entities shall be responsible or liable for any loss or damage, directly or indirectly, arising from the
use of or reliance upon any information provided in this document.

Additional disclaimer for CES China 120 Index Futures

CES China 120 Index (“CES 120 Index”) are calculated and / or disseminated by China Securities
Index Company Limited (“CSIC”) on behalf of China Exchanges Services Company Limited
(“CESC”). Neither CESC nor CSIC guarantee (expressly or impliedly) the accuracy, completeness,
timeliness or fitness for a particular purpose of the CESC Index and/or the information contained
therein; nor do they accept any liability for any damages, loss, costs or expenses suffered by any
person arising from the use of the CESC Index and/or the information contained therein.
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Equity Indices Monthly Performance in March 2021

Sector Indices vs HSI / HSCEI CES120 vs China Theme Indices

Index Name Index Name

|

HS Mainland

Banks Index +5.8%

CES120 Index -4.5%

HSI -2.1%

CSI 300 Index -5.4%

HSCEI -2.4%

HS Mainland o
Properties Index h +6.1% HSCEI -2.4%

I

HS Mainland . FTSE A50 Index  -5.7%
Oil& Gas Index 3%

% Change % Change
Equity Index Futures Access Codes

HS Mainland HS Mainland
Vendor HS Mainland Banks Properties Oil & Gas CES 120 HSI HSCEI
Bloomberg BMWA PPTA OGIA CESA HIA HCA
Refinitiv 0#HMBI: O#HMPI: 0#HMOI: O#HCHH: 0#HSI: O#HCEL:
WIND MBIF MPIF MOIF CHHF HSIF HHIF
ET Net MBI MPI MOI CHH HSI HHI

Data Source: Bloomberg
As at 31 March 2021

Information for reference only
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Equity Index Futures & Options

Hang Seng Index (HSI) Futures & Options

HSI Products

(2021 vs 2020)

HSI Futures

Mini-HSI Futures

HSI Options

Mini-HSI Options

HSI Volatility

Index Futures

HSI Dividend
Point Index
Futures

Data Source: HKEX

164,096 (-2%)

119,995 (+7%)

33,963 (-14%)

13,094 (-3%)

0 (-100%)

76 (-25%)

* Ol compared to previous year-end
Information for reference onlv

As at 31 March 2021

X

109,854 (-15%)

10,367 (-40%)

165,533 (+2%)

14,798 (+71%)

0()

4,211 (+9%)

Av erage Daily Volume
(No. of Contracts)

280,000 ~
240,000 -
200,000 -
160,000 -

120,000 -/‘N
80,000 -
40,000 -

0 - A

HSI Futures (MoM)

HSI Futures (YoY)

mmmmm ADV (L-AXxis)
Open Interest (R-AXxis)

N

Open Interest
(No. of Contracts)

r 200,000

- 150,000

- 100,000

- 50,000

Av erage Daily Volume
(No. of Contracts) (

150,000

100,000

50,000

mmmmm ADV (L-AXxis)

pen Interest (R-AXis)
1] A P

Open Interest
No. onContracts)

- 150,000
- 100,000

- 50,000

HSI Options (YoY)

Av erage Daily

Volume

(No. of Contracts)

45,000 H

30,000 -

15,000 -

ADV (L-Axis)
Open Interest (R-Axis)

Open Interest

(No.

HSI Options (MoM)

Av erage Daily Volume

(No. of Contracts)

45,000 ~

30,000 ~

15,000 -

ADV (L-Axis)
Open Interest (R-Axis)

of Contracts)
400,000

300,000

200,000

- 100,000

Open Interest
(No. of Contracts)
r 600,000

- 400,000

- 200,000




Equity Index Futures & Options
HSI Futures & Options

Hang Seng Index HSI vs VHSI Price Level HSI & Top 5 Constituents

. Includes the largest and most ‘000
Index Description iouid stocks listed i ('000)
L3-8 S e EES) e PO 327 ——HsI ——VHSI 130 57— psiindex  —— Tencent

Index Level 28,378.35 (As at 31 Mar 2021) 28 135 - HSBC —AlA

30 — China Mobile
Index Volatility (30-Day Historical) | 22.7 - 26 125
Index Avg. Day High-Low Range 472.08 (Mar 2021) 28 r 24 115

- 22

HSCEI Correlation (2021) 0.955 105

26 - - 20

18 B
Hang Seng Index Futures 24 . . 16 85
Jan-21 Feb-21  Mar-21 Jan-21 Feb-21 Mar-21
Contract Multiplier HK$50
Notional Value (1 Contract) HK$1.42Mn (As at 31 Mar 2021) Distribution of HSI Index Options Ol in Month-end
Call Put

Transaction Cost* 372

5 372 8352
Stamp Duty N/A 8 352 §33 5

S 332 ®31.2
Trading Fee HK$10 / contract g 312 5 29.2

& 292 Q 27.2

27.2 =< <

SFC Levy HK$0.54 / contract L 555 5252

N 232 % 23.2
Commission Rate Negotiable S 212 g 21.2

2 196 =196
Margin as of 01 Mar 2021 HK$97,800 18.6 86—

140 ¢ T T 14.0 T r )
0 2 4 6 0 2 4 6
Open Interest (*000) Open Interest (‘000)

Data Source: HKEX, Bloomberg

* All calculations are in HKD and exclude commission fees
Information for reference onlv

As at 31 March 2021
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Equity Index Futures & Options
Hang Seng China Enterprises Index (HSCEI) Futures & Options

- HSCEI Futures (YoY)
Ool*

HSCEI Options (YoY)

HSCEI Products

ADV
(2021 VS 2020) Average Daily Volume Open Interest  Average Daily Volume Open Interest
(No. of Contracts) (No. of Contracts)  (No. of Contracts) (No. of Contracts)
160,000 - == ADV (L-AXxis) - 600,000 120,000 - ADV (L-Axis) - 2,800,000
Open Interest (R-Axig) Open Interest (R-Axis)
L . - 2,400,000
HSCEI Futures 133,426 (-8%) 243,761 (-16%) 190000 - 500,000 100,000
- 400,000 80,000 - - 2,000,000
- 1,600,000
80,000 - - 300,000 60,000 -
6 - 1,200,000
Mini HSCEI - 1
17,791 (-2%) 4,336 (+3%) 40,000 - 200,000 40,000 - 800,000
Futures - 100,000 20,000 - 400,000
0 - 0 0 LN B B B B B B B B B R 0
&) O N O v A 9O R
O S N AR N N NN
S S S S S o

HSCEI Options 50,944 (-39%) 1,375,616 (-8%)
HSCEI Options (MoM)

Open Interest

HSCEI Futures (MoM)

Av erage Daily Volume Open Interest  Average Daily Volume

M|n| HSCEI 1.693 (_25%) 5414 (+55%) (No. of Contracts) (No. of Contracts)  (No. of Contracts) (No. of Contracts)
Options 220,000 - mmmm ADV (L-Axis) - 600,000 150,000 - ADV (L-Axis) - 4,000,000
o Open Interest (R-Axis) - 500,000 Open Interest (R-Axis)
HSCEI Dividend 165,000 - - 3,000,000
Point Index 1,718 (-5%) 78,542 (+49%) N . I 400,000 100,000 1
Futures 110,000 I - 300,000 - 2,000,000
- 200,000 |
55,000 - 50,000 - 1,000,000
- 100,000 OO0,
0 ] - O 0 > > Q 0
= csoahn c =
2853735858588
2020 2021

Data Source: HKEX
* Ol compared to previous year-end
Information for reference onlv

As at 31 March 2021
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Equity Index Futures & Options
HSCEI Futures & Options

HSCEI HSI vs HSCEI

Comprises the largest and
Index Description p.| ] 9
most liquid H shares 104 4
eS| e—HSCE|
Index Level 10,972.04 (As at 31 Mar 2021) 102 A
Index Volatility (30-Day Historical) | 23.7 100 1
Index Avg. Day High-Low Range 204.38 (Mar 2021) 9 1
96
Correlation with HSI, CES120 (2021)| 0.955,0.892
94 1
Correlation with CSI300, FTSE A50 0.7.0.697 92 . . . .
(A=) S S S < <
xgb ,@(b Q’b Q’b Q'
SN AN A LA

Contract Multiplier

HK$50

Notional Value (1 Contract) HK$0.55Mn (As at 31 Mar 2021) Call
17.2
s 15.2
Transaction Cost* g 140
T 13.0
9 12.0
D A Q
Stamp Duty N/ £ 110
. @ 10.0
Trading Fee HK$3.5 / contract = 9.0
g9
< 80
SFC Levy HK$0.54 / contract % 66
£ 46
Commission Rate Negotiable 2.0 ¢ T )
0 20 40
Margin as of 01 Mar 2021 HK$38,400 Open Interest ('000)

Data Source: HKEX, Bloomberg
* All calculations are in HKD and exclude commission fees
Information for reference onlv

As at 31 March 2021

X

HSCEI & Top 5 Constituents

1251 —hiscEl Ping An
- |CBC - CCB
BOC = China Life

115
105

95

85

Jan-21 Feb-21 Mar-21

Put

—

0 20 40 60 80
Open Interest ('000)



Weekly HSI & HSCEI Options Performance

Contract Multiplier HK$50 v
olume
o . Akuna, Eclipse, I-Access, IMC, Maven,  (No. of Contracts)
Liquidity Providers .
Optiver 18,000 - .
m Weekly HSI Options
. 15,000 ®m Weekly HSCEI Options
Transaction Cost* 12,000
Stamp Duty N/A 9,000
Trading Fee HK$10 / contract 6,000
SFC Levy HK$0.54 / contract 3,000
- . 0
Commission Rate Negotiable DNDDONNDNNNDNDNNDDNDNODM
TN IFTFHNDOCIANNOCORNDOTANITIN O D O
A A A NN NANNNOMOM
i Volume
Weekly HSCEI Options e ontracts)
Contract Multiplier HK$50 -
P " ! A MC. M 10,000 —=\Neekly HS| & HSCEI Options Call
Liquidity Providers (')A\ptlijvr;erh Eclipse, I-Access, IMC, Mawen, 8,000 - ——Weekly HSI & HSCEI Options Put
6,000 -
Transaction Cost* 4,000 -
Stamp Duty N/A 2,000 -
Trading Fee HK$3.5 / contract 0 ———
LA NAQANQNARQDQQD
SFC Levy HK$0.54 / contract TAMIFTO OIS AN NISaNAIROISd
Commission Rate Negotiable

An investment tool to manage short term event risk

Data Source: HKEX

* All calculations are in HKD and exclude commission fees
Information for reference onlv

As at 31 March 2021
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Equity Futures & Options
Single Stock Futures & Options

Single Stock Derivatives ADV (2021 vs 2020) _— No. of Single Stock Derivatives

Stock Futures 13,683 (+198%) 38,583 (+68%) Single Stock Futures
Stock Options 826,689 (+57%) 10,890,603 (+22%) Single Stock Options 111
Stock Futures (YoY) Stock Options (YoY) Latest and Future Developments
Av erage Daily Volume Open Interest ~ Average Daily Volume Open Interest
(No. of Contracts) (No. of Contracts)  (No. of Contracts) (No. of Contracts)
16,000 |  mmmmm ADV (L-Axis) _ r 45,000 1,000,000 - ADV (L-Axis) - 12,000,000 ST AN
14,000 - Open Interest (R-AXxis) [ gg,ggg 800.000 - Open Interest (R-Axis)/ | 10,000,000
12,000 - ' ' * Product
10000 - 30,000 00000 - 8,000,000 roducts
8’000 i - 25,000 ' - 6.000.000 » 3 A-shares ETFs futures contracts
’ - 20,000 400,000 - L > Total 83 stock futures contracts
6,000 - 15,000 ! ~ 4,000,000
4,000 - - 10,000 200,000 - -
2,000 [ 5,000 2,000,000
0 - L 0 O T T T T T T T T T T T T O
O N B B A 9 X SO X
(19% (19\ ‘19\ (19\ {19\ q,Q\ (19(,/ S D S (19’1/
Stock Futures (MoM) Stock Options (MoM) Stock Options
Av erage Daily Volume Open Interest Average Daily Volume Open Interest * Products .
(No. of Contracts) (No. of Contracts) ~ (No. of Contracts) _ (No. of Contracts) » 3 A-shares ETFs options contracts
_ mmmmm ADV (L-AXis) _ 1,000,000 - ADV (L-Axis) - 16,000,000 R
16,000 Open Intereat (R-Axis)._[ 45000 Open nterest (R-Axis) > Total 111 stock options contracts
14,000 1 20000 800,000
12,000 - [ 32000 ’ - 12000000, Market Makers (MMs)
12’888 ] - 25.000 600,000 1 Af\/\/\ | 8.000.000 » 3 types of market makers (PMM/ CQMM/
6.000 - I ig,ggg 400,000 - QRMM)
4,000 - - 10,000 200,000 - - 4,000,000 » CQMM to provide 50 series continuous
2,000 - - 5,000 guotations
01 0 0 > > O 0
= 2N = o+t > O = s csoan c =
2853353828588 285335888588
2020 2021 2020 | 2021

Data Source: HKEX

* Ol compared to previous year-end
Information for reference onlv

As at 31 March 2021
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Hang Seng TECH Index Futures and Options Performance

Hang Seng TECH Index Open Interest (as of 31 March 2021)

Tracks the largest technology companies
Index Description
listed in Hong Kong Open Interest
(No. of Contracts)
24,000 -
Hang Seng TECH Index Futures & Options 20,000 -
Contract Multiplier HK$50 per index point 16.000 -
Notional Value (1 Contract) HK$409K (As at 31 March 2021) 12.000 -
No. of Liquidity Providers Futures: 4; Options: 6 8000 -
4,000 - .
Transaction Cost* 0 —
Stamp Duty NA 3 8 ‘ S g CETS
Trading Fee HK$5.00 / contract < o | i - |
SFC Levy HK$0.54 / contract 2020 2021
Average Daily Volume (as of March 2021)
ADV
(No. of Contracts)
10,000 -
8,000 -
6,000 -
4,000 -
2,000 -
. oom
> ) ‘ c o =
5 o) @ ) a
z a) ~ L =
2020 | 2021

Providing investors with a tool to manage their risk exposure

; . Volume and Open Interest are Incubating
to Hong Kong-listed technology companies

Data Source: HKEX

* Exclude commission fees

Information for reference onlv

As at 31 March 2021
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MSCI Asia and Emerging Market Index Futures Performance

MSCI Asia and Emerging Market Index Open Interest (As of 31 March 2021)

representation 38 DM and EM countries and

Index Description ; o Open Interest
regional indices (No. of Contracts)
100,000 -
MSCI Asia and Emerging Market Index Futures 80,000 -
Contract Multiplier Average US$40 60.000 -
Notional Value (1 Contract) Average US$50K (As at 31 March 2021)
No. of Liquidity Providers 14 40,000 1
20,000 -
Transaction Cost* 0
Stam p Duty N/A
Trading Fee US$0.6-US$1.0 / contract
2020 2021
SFC Levy US$0.07 / contract
Average Daily Volume (As of March 2021)
ADV
(No. of Contracts)
10,000 -
8,000
6,000
4,000
2,000

0

o
[}
%2}

2020 2021

HKEX with the broadest suite of MSCI derivatives products

. . . Volume and Open Interest continue to growth
based in the Asian time-zone

Data Source: HKEX
* Exclude commission fees
Information for reference onlv

As at 31 March 2021

X
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MSCI AC Asia ex Japan NTR Index (AxJ) Futures Performance

i Dasetsten representation 2_ DM cour_1tries (excl. Japan) Open Interest
and 9 EM countries in Asia (No. of Contracts)
20,000 -
Index Level 654.08 (As at 31 March 2021) '
Index Volatility (30-Day Historical) | 21.8 15,000
Index Avg. Day High-Low Range 9.02 (March 2021) 10,000
HSI Correlation (2021) 0.89 5,000
HSCEI Correlation (2021) 0.888 0
MSCI AxJ Futures
Contract Multiplier US$100
Notional Value (1 Contract) US$65K (As at 31 March 2021)
Avg. Quote Size US$0.33Mn (5 Contracts) MSCI AxJ Combines Developed and Emerging Markets (Rebased to 100)
Avg. Bid-Ask Trading Spread 1.1 index points (March 2021) 130 - MSCIAJ e MSCI China MSCIHK
MSCISG =~ e MSCl India o MSCI Indonesia

S S P O =~ | MSCI Korea - MSCI Malaysia MSCI Pakistan
Liquidity Providers Flow and 11 banks 120 4 MSCI Philippines MSCI Taiwan MSCI Thailand
Transaction Cost* 110
Stamp Duty N/A 100
Trading Fee US$0.5 / contract 9
SFC Levy US$0.07 / contract

. 80 T T

Margin as of 01 Mar 2021 US$3,410 Jan-2021 Feb-2021 Mar-2021

MSCI AxJ is a well-established benchmark representing Asia

Futures contracts have relatively lower transaction costs : . :
regional (excluding Japan) equity market performance

Data Source: HKEX
* All calculations are in USD and exclude commission fees
Information for reference onlv

As at 31 March 2021
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Hang Seng Mainland Banks Index Futures Performance

Hang Seng Mainland Banks Index (HSMBI)

Index Description

Index Level

Index Volatility (30-Day Historical)
Index Avg. Day High-Low Range
HSI Correlation (2021)

HSCEI Correlation (2021)

10 largest and most representative
HKEX-listed mainland banks stocks

3,095.03 (As at 31 March 2021)
24.7

45.77 (March 2021)

0.646

0.633

Hang Seng Mainland Banks Index Futures

Contract Multiplier

Notional Value (1 Contract)
Avg. Quote Size

Avg. Bid-Ask Trading Spread

Liquidity Providers

Transaction Cost*

Stamp Duty
Trading Fee
SFC Levy

Margin as of 01 Mar 2021

HK$50

HK$0.15Mn (As at 31 March 2021)
HK$0.77Mn (5 Contracts)

52.8 index points (March 2021)

N/A

N/A
HK$2 / contract
HK$0.54 / contract

HK$7,450

Futures contracts have relatively lower transaction costs

Data Source: HKEX, HSIL, Bloomberg

* All calculations are in HKD and exclude commission fees

Information for reference onlv

As at 31 March 2021

X

5-Min Avg. Bid-Ask Spreads (31 March 2021)

Bank of China 3988.HK

Minsheng Bank 1988.HK

HSMBI Futures 1.72%
CEB Bank 6818.HK

ABC 1288.HK

Bankcomm 3328.HK

CITIC Bank 998.HK
PSBC 1658.HK
ICBC 1398.HK
CCB 939.HK

CM Bank 3968.HK

Index & Constituents 3-Month Performance (Rebased to 100)

125

120

115

110

105

100

95

Jan-2021

: —— ABC (1288.HK)

——HSMBI
ICBC (1398.HK)

——CCB (939.HK)
BOC (3988.HK)

Feb-2021 Mar-2021
HSMBI Futures can be used for hedging

13



Hang Seng Mainland Oil & Gas Index Futures Performance

Hang Seng Mainland Oil & Gas Index (HSMOGI) 5-Min Avg. Bid-Ask Spreads (31 March 2021)

7 largest and most representative

Index Description
P HKEX-listed mainland oil & gas stocks HSMOGI Futures

2.57%

Index Level 1,194.19 (As at 31 March 2021)

PetroChina 857.HK
Index Volatility (30-Day Historical) | 40.0

} China Qilfield 2883.HK
Index Avg. Day High-Low Range 22.63 (March 2021)

HSI Correlation (2021) 0.554 Kunlun Energy 135.HK

HSCEI Correlation (2021) 0.513

Sinopec Corp 386.HK

Hang Seng Mainland Oil & Gas Index Futures CNOOC 883HK

Contract Multiplier HK$50
Notional Value (1 Contract) HK$60K (As at 31 March 2021)
Avg. Quote Size HK$0.30Mn (5 Contracts) Index & Constituents 3-Month Performance (Rebased to 100)
Avg. Bid-Ask Trading Spread 27.3 index points (March 2021) 160 - e HSMOGI —— PetroChina (857.HK)
Liquidity Providers o 150 - —— CNOOC (883.HK) Sinopec Corp (386.HK)
Kunlun Energy (135.HK)
140 -
Stamp Duty N/A 120 .'./4‘\\
Trading Fee HK$2 / contract 110 1 /_P't -/—/_/
SFC Levy HK$0.54 / contract 100 hant N
Margin as of 01 Mar 2021 HK$5,900 o oal Feb-2021 Mar-2021
Futures contracts have relatively lower transaction costs HSMOGI Futures can be used for hedging

Data Source: HKEX, HSIL, Bloomberg
* All calculations are in HKD and exclude commission fees
Information for reference onlv

As at 31 March 2021
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Hang Seng Mainland Properties Index Futures Performance

Hang Seng Mainland Properties Index (HSMPI)

10 largest and most representative

Index Description ) ) .
HKEX-listed mainland properties stocks

Index Level 6,881.34 (As at 31 March 2021)
Index Volatility (30-Day Historical) | 33.0

Index Avg. Day High-Low Range 110.86 (March 2021)

HSI Correlation (2021) 0.51

HSCEI Correlation (2021) 0.551

Hang Seng Mainland Properties Index Futures

Contract Multiplier HK$50

Notional Value (1 Contract) HK$0.34Mn (As at 31 March 2021)
Avg. Quote Size HK$1.7Mn (5 Contracts)
Avg. Bid-Ask Trading Spread 87.9 index points (March 2021)

NA

Liquidity Providers

Transaction Cost*

Stamp Duty N/A

Trading Fee HK$2 / contract
SFC Levy HK$0.54 / contract
Margin as of 01 Mar 2021 HK$18,530

Futures contracts have relatively lower transaction costs

Data Source: HKEX, HSIL, Bloomberg
* All calculations are in HKD and exclude commission fees
Information for reference onlv

As at 31 March 2021

b

5-Min Avg. Bid-Ask Spreads (31 March 2021)

Fullshare 607.HK 1.26%
China Res Land 1109.HK
China Overseas 688.HK
Kerry Ppt 683.HK
Shimao Property 813.HK
Sino-Ocean Gp 3377.HK
Evergrande 3333.HK
China Vanke 2202.HK
Country Garden 2007.HK
HSMPI Futures

Longfor PPT 960.HK

Index & Constituents 3-Month Performance (Rebased to 100)

135

125

115

105

95

85

75

Jan-2021

_| e HSMPI
China Overseas (688.HK)
China Res Land (1109.HK)

Evergrande (3333.HK)
Country Garden (2007.HK)

Feb-2021 Mar-2021

HSMPI Futures can be used for hedging

15



CES120 Index Futures Performance

CES120 Index 5-Min Avg. Bid-Ask Spreads (31 March 2021)

L 80 A-Shares and 40 HK-listed Mainland
Index Description . ) )
China H-shares, P-chips, and red chips
CES120 Futures 1.02%
8,439.08 (As at 31 March 2021)

Index Level

Index Volatility (30-Day Historical) | 20.9
CSOP FTSE AS0 ETF (2822.HK) - 0.17%
Index Avg. Day High-Low Range 153.66 (March 2021)

CSI300 Correlation (2021) 0.918

XiShares A50 ETF (2823.HK) . 0.08%
FTSE A50 Correlation (2021) 0.924

i 0,

CES120 Index Futures ChinaAMC CSI300 ETF (3188.HK) F 0.08%
Contract Multiplier HK$50
Notional Value (1 Contract) HK$0.42Mn (As at 31 March 2021)
Average Quote Size HK$2.11Mn (5 Contracts) CES120 & Top Constituents’ 3-Month Performance

(Rebased to 100)
Average Bid-Ask Trading Spread| 84.4 index points (March 2021)

140 e CES120 Index Tencent ccB
Liquidity Providers N/A Ping An ——— China Mobile
130
Transaction Cost* 120
Stamp Duty N/A 110
Trading Fee HK$5 / contract
100
SFC Levy HK$0.54 / contract
i 90 r .
Margin as of 01 Mar 2021 HK$23,130 Jan-2021 Feb-2021 Mar-2021
Futures contracts have relatively lower transaction costs CES120 Futures can be used to hedge A-share positions

Data Source: HKEX, HSIL, Bloomberg
* All calculations are in HKD and exclude commission fees
Information for reference onlv

As at 31 March 2021
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Hang Seng TECH Index Futures and Options Access Codes

Information Vendor Hang Seng TECH Index Futures Hang Seng TECH Index Options

AAStocks 221014 322400

ACTIV Financial HTIl/<yy><m>.HF HTIl/<yy><mm>/<strike><t>.HF
Bloomberg L.P. HCTA Index HSTECH Index OMON
Colt Technology HTImy HTI<Strikes>my

DB Power Online HTI HTI

DzZH HTI

East Money HTI

Information

ESunny Information ~ HTI HTI

ETNet HTI HTI

Hexin Flush HTI HTI

Infocast Ltd HTI HTI

N2N-AFE 870840 873201-7

QianLong 229

Refinitiv O#HHTI O#HTI*.HF

Shanghai Pobo HTI + Month Code

WebStock HTI HTI

Wind HTIF.HK HTIO.HK

Data Source: HKEX
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MSCI Asia and Emerging Market Index Futures Access Codes

MSCI China ia [MSCI EM Asia MSCI EM MSCIEM ex |MSCIEMex |MSCIEM
. Free NTR i ex Korea NTR [MSCI EM Asia [EMEA NTR China NTR Korea NTR LatAm NTR
Information [NTR (USD) Free (USD) (USD) Index (USD) Index  [NTR (USD) (USD) Index  |[(USD) Index |(USD) Index |(USD) Index
Vendor Index Futures |Index Futures |[Futures Futures Index Futures |Futures Futures Futures Futures
Bloomberg HKCA Index HMSA Index  HJEA Index HQOA Index HQRA Index HRSA Index HQTA Index HQDA Index  HQIA Index HQYA Index
Refinitiv 0#HMAN: 0#HMCU: 0#HMCN: 0#HMAC: 0#HMAK: O#HEAN: 0#HMEE: 0#HMXC: 0#HMXK: O0#HMEL:
WIND MANF.HK MCNF.HK EANF.HK

MSCI Hong MSCI MSCI
. Kong NTR MSCI India MSCI India Indonesia Indonesia NTR|MSCI Japan  |MSCl Japan [MSCI Japan
Information (USD) Index  |(USD) Index |NTR (USD) Index (USD) |(USD) Index [(JPY) Index NTR (JPY) NTR (USD)
Vendor Futures Futures Index Futures |Futures Futures Futures Index Futures |Index Futures
Bloomberg HMPA Index  HMOA Index  HLCA Index HRTA Index HJDA Index HMLA Index HKBA Index HQAA Index  HQBA Index  HJCA Index
Refinitiv O#HMEM: O#HEMN: O#HMHN: O#HMDA: O#HMIN: 0#HMID: 0#HMDN: O#HMJP: O#HMJJ: 0#HMJU:
WIND MINF.HK MDNF.HK MJUF.HK

MSCI
MSCI New MSCI Pacific MSCI MSCI Singapore MSCI
: MSCI Malaysia [MSCI Malaysia |Zealand NTR [ex Japan NTR |[MSCI Pacific |Philippines ilippi Singapore Free NTR Singapore

Information [USD) Index |NTR (USD) (USD) Index  |(USD) Index |NTR (USD) (USD) Index Free (SGD) (USD) Index  |NTR (USD)

Vendor Futures Index Futures |Futures Futures Index Futures |Futures Index Futures |Index Futures |Futures Index Futures
Bloomberg HMYA Index HKEA Index HOPA Index HRPA Index HRBA Index  HNSA Index HLEA Index HKOA Index HOBA Index HKPA Index
Refinitiv 0#HMMY: 0#HMMN: 0#HMNZ: 0#HMPJ: 0#HMPC: 0#HMPH: 0#HMPN: 0#HMSG: 0#HMGN: O#HMSN:
WIND MMNF.HK

MSCI Taiwan
: MSCI Taiwan [MSCI Taiwan |25/50 NTR MSCI Taiwan [MSCI Thailand |MSCI Thailand [MSCI Vietnam [MSCI Vietnam
Information [USD) Index  [25/50 (USD)  |(USD) Index  |NTR (USD) (USD) Index  [NTR (USD) (USD) Index  [NTR (USD)
Vendor Futures Index Futures |Futures Index Futures |Futures Index Futures |Futures Index Futures
Bloomberg HJAA Index HRCA Index HRDA Index HJBA Index HMTA Index HKDA Index HNTA Index HKSA Index
Refinitiv O#HMTW: O#HTWP: O#HTWN: O#HMWN: O#HMTH: O#HMTN: O#HMVT: O#HMVN:
WIND MTWFE.HK MWNF.HK MTNF.HK

Data Source: HKEX
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Weekly HSI and HSCEI Options Access Codes

Hong Kong and International Information Vendors

AASTOCKS 322105 322125

Bloomberg HSI Index OMON HSCEI Index OMON

DB Power HSI HHI

ET Net Limited Menu "Futures/Options" > "Futures/Options Quotation (Short-term)“ > Access code: The series name
Infocast HSI HHI

MegaHub Limited HSI HHI

N2N-AFE 873101 873121

Refinitiv <O#HSIW*.HF> <O#HCEIW*.HF>

Tele-Trend File->Open->Options->HSI File->Open->Options->HHI

MSCI AxJ and MSCI AxJ Futures Access Codes

Hong Kong and International Information Vendors

AASTOCKS - 221495
Activ Financial - MXJ/<yy><m>.HF
Bloomberg M1ASJ Index MJSA Index CT
CQG - MXJ

DB Power - MXJ

East Money Information - MXJ
Factset - MXJE

ICE Data Services - F:MXJ
Infocast - MXJ
N2N-AFE - 870823
QPWeb - P11203

SIX Financial Information - MXJImy
Refinitiv .MIAX00000NUS 0#HMXJ:
Telequote Data - MXJ/<yy><m>.HF
Tele-Trend - MXJFC, MXJmyy

Data Source: HKEX

X
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Sector Index and Sector Index Futures Access Codes

Hong Kong and International Information Vendors

Mainland Banks
Index

Information Vendor

AASTOCKS

Activ Financial =0200700.HK
AFE 837451
Bloomberg HSMBI Index
DB Power

ET Net MBN
Infocast HSMBI
QuotePower SEHK.HHSMBI
Telequote

Refinitiv .HSMBI

Mainland Information Vendors

Mainland Banks
Index

Information Vendor

East Money HSMBI
Hexin Flush Financial

Pobo Financial

Qianlong 999905
Wind HSMBI

Data Source: HKEX

X

Mainland Banks
Index Futures

221420
MBI/16K.HF
870809
BMWA Index

MBI
MBI
MBI

P11223

MBImy
O0#HMBI:

Mainland Banks
Index Futures

MBI
MBIC
MBI+Month+Ye
ar

209

MBIF+yymm-+H
K

Mainland Mainland
Properties Properties Index
Index Futures
221425
=0200800.HK MPI/16K.HF
837451 870810
MSMPI Index PPTA Index
MPI
MPR MPI
MSMPI MPI
SEHK.HHSMPI P11224
MPImy
.HSMPI O#HMPI:
Mainland Mainland
Properties Index | Properties Index
Futures
HSMPI MPI
MPIC

MPI+Month+Year
999902 209

HSMPI MPIF+yymm-+HK

Mainland Oil
& Gas Index

=0201000.HK
837451
HSMOGI Index

MOG

MOGI

SEHK.HHSMO
Gl

.HSMOGI

Mainland Oil
& Gas Index

HSMOGI

999903

HSMOGI

Mainland Oil &
Gas Index
Futures

221415
MOI/16K.HF
870808
OGIA Index

MOl
MOl
MOl

P11222

MOImy
0#HMOI:

Mainland QOil &

Gas Index

Futures

MOI
MOIC
MOI+Month+Ye
ar

209

MOIF+yymm+H
K
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CES120 Index and CES120 Index Futures Access Codes

Hong Kong and International Information Vendors

Information Vendor | CES 120 Index | CES 120 Index Futures
Bloomberg Finance L.P. CES120 CESA Index DES <GO>
Refinitiv .HKCES120 O#HCHH:
AAStocks.com Limited 110056 221360
AFE Solutions Ltd. 837505 870800

DB Power Online Limited CES120 CHH

ET Net Limited CEC CHH
Infocast Limited CE120 CHH
Interactive Data Group I:CES120 Fn:CHH\MYYDD
Marketprizm Hong Kong Limited CES120 CHHmy
SIX Financial Information Ltd. CES120 CHHmy
Telequote Data International Limited CES120 CHHmy

Mainland Information Vendors

Information Vendor CES 120 Index CES 120 Index Futures

Hithink RoyalFlush Information Network Ltd CES120 CHHC

Shangahai DZH Limited CES120 CHH+Month Code+Year Code
Shanghai Gildata Services Co Ltd CES120 -

Shanghai Wind Information Co., Ltd CES120 CHHF+yymm+.HK
Zheng Zhou Esunny Information Technology Co,

Ltd. i CHH

Shanghai Wenhua Financial Information Ltd - CHHmy

Shanghai Qianlong Advanced Technology Co Ltd CES120 Page 209

Data Source: HKEX

X



